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SDL Trados Studio 2011 SP2 - Release Notes 

Copyright 2000 - 2012 SDL plc. 

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including those in 
copyright in the content of this website and documentation are owned by or controlled for these 
purposes by SDL PLC. Except as otherwise expressly permitted hereunder or in accordance with 
copyright legislation, the content of this site, and/or the documentation may not be copied, 
reproduced, republished, downloaded, posted, broadcast or transmitted in any way without the 
express written permission of SDL PLC. 

This product may include open source or similar software designated: Hunspell distributed under GNU 
Lesser General Public License version 3; Sharpziplib and Spring.net distributed under GNU General 
Public License version 3; ICU distributed under IBM ICU License; Log4Net, Xalan and Xerces 
distributed under Apache License version 2.0; Wix distributed under Common Public License version 
1.0; and SQLite which is public domain and requires no license for this distribution. 

Trados, MultiTerm, SDL PerfectMatch, SDLX, Passolo and TranslationZone are registered trademarks 
of SDL plc. Translator's Workbench, Trados Studio, TagEditor, QuickPlace, AutoSuggest, BeGlobal and 
GlobalConnect are trademarks of SDL plc.. All other trademarks are the property of their respective 
owners. The names of other companies and products mentioned herein may be the trademarks of 
their respective owners. Unless stated to the contrary, no association with any other company or 
product is intended or should be inferred. 

Although SDL takes all reasonable measures to provide accurate and comprehensive information 
about the product, this documentation is provided as-is and all warranties, conditions or other terms 
concerning the documentation whether express or implied by statute, common law or otherwise 
(including those relating to satisfactory quality and fitness for purposes) are excluded to the extent 
permitted by law. 

Information in this documentation, including any URL and other Internet Web site references, is 
subject to change without notice. Without limiting the rights under copyright, no part of this 
documentation may be reproduced, stored in or introduced into a retrieval system, or transmitted in 
any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any 
purpose, without the express written permission of SDL plc. 
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1  SDL Trados Studio Overview 
 

SDL Trados Studio 2011 enables organizations to effectively manage all aspects of translation 
projects. SDL Trados Studio 2011 incorporates project management, computer-aided translation 
(CAT) as well as terminology management tools for use by project managers, translators, editors, 
proofreaders, terminologists and other language professionals. These are presented in easy-to-use 
views which you can arrange to look and work the way that you prefer. For more information on SDL 
Trados Studio 2011, refer to the online help, user guides and videos. 

SDL Trados Studio 2011 is used with a softkey license based on an activation code. For more details 
on how the softkey license mechanism works and how to obtain and install softkey licenses, see the 
licensing documentation and the information provided in the SDL Support Center at 
http://support.sdl.com. 

Note: the Freelance and Starter versions of SDL Trados Studio 2011 cannot run on a domain-based 
network. This behavior is by design. If you wish to run SDL Trados Studio 2011 on a domain-based 
network, you need to work with the Express or Professional version.  

For more information, see http://www.sdl.com/en/language-technology/products/translation-memory/. 
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2 What’s New in SP2 
These release notes cover the latest release of SP2 that is labeled as SP2R in the Help > About SDL 
Trados Studio menu in Studio. If you have an earlier version labeled as just SP2, we recommend 
that you upgrade. The latest release delivers the usability enhancements that are mentioned below 
and the new features and functionality from the first SP2 release in the following areas:  

2.1 Translating for regulated industries 
When translating for a regulated industry where pharmaceutical companies localize labels for 
medication or product information, any changes that occur in the source language needs to be 
mirrored in the languages to which you are translating. Some of the features implemented in this 
release ensure that any changes are tightly controlled when they go into the target translations.  

For the best practices and settings that are recommended for translation using the features in this 
release, see the Translating for a Regulated Industry book in the SDL Trados Studio Help. 

2.2 Enhanced track changes behavior 

Show/Hide tracked changes in translation – Final Mode 
Viewing your document in Final Mode hides tracked changes from view in the Editor. This mode 
previews what the text of the document would look like if all suggested changes were accepted. If you 
edit the document in Final Mode, it still tracks your changes without showing the track changes 
markup.  

Confirm translations and update the TM with tracked changes 
Segments containing tracked changes in the source and/or target can be confirmed. When you 
confirm a segment with tracked changes, the TM is updated with all changes accepted.  

Preview translations containing tracked changes 
When previewing documents that contain tracked changes, you can only see the tracked changes in 
the preview for Microsoft Word 2007-2010 documents (.docx).  For all other file types, tracked 
changes will appear as if they are accepted in the preview. 

Generate the final translated documents with tracked changes 
If your document contains tracked changes, those tracked changes appear in the final translated 
document for Microsoft Word 2007-2010 documents (.docx). You can then do your final accepting or 
rejecting of changes in Microsoft Word. 

For all other file types, tracked changes will automatically be accepted in your SDL XLIFF document 
and then the final document is generated. 



 

SDL Trados Studio 2011 SP2 Release Notes Page 7	

TM lookups with tracked changes in the source 
When you have tracked changes in the source and a lookup is performed (during interactive 
translation in the Editor or pre-translation), a lookup is first made in the TM with tracked changes 
rejected.  

 If an exact match (100%) is found for the rejected version of the segment, it applies the 

translation with the following icon in the segment status column  and that status of the 
translation is set to Draft. A second lookup is then performed with the tracked changes 
accepted and the results are displayed in the Translation Results window. This gives you 
maximum leverage for segments that contain tracked changes.  

 If no exact match is found with the tracked changes rejected, it applies the translation from the 
lookup that was performed with tracked changes accepted.  

Note:  When analysis is performed on project files, the tracked changes are treated as if they are 
accepted. This results in giving accurate fuzzy matching results for segments with tracked changes to 
feed into the budgeting process for documents with tracked changes. 

Apply TM matches with Track Changes enabled 
If you have Track Changes enabled, it is automatically turned off when the TM match is applied to 
your document. You can change this setting in the Options dialog box under Editor > Automation. 

New colors for tracked changes 
To distinguish the colors used when tracking changes in the Editor and showing differences in the 
source when in the Translation Results window, the colors used in tracked changes are now the 
following: 

 Deleted terms are shown in dark red with a line through them to indicate that you have 
deleted the word:  Fotodrucker 

 Inserted terms are shown in purple with a line underneath to show that you inserted a word:  
Drucker 

2.3 New source segment functionality 

View source document information 
You can now view tracked changes in Studio that were applied to the original source document. This 
feature is only available for Microsoft Word 2007-2010 format (.docx). 

 When the document is opened in the Editor, tracked changes applied to the original source 
document are displayed in the source segments.  

 Use the Segment Review options on the Display Filter toolbar to view only segments that 
contain tracked changes in your document.  This filter applies to tracked changes in the 
source and target segments. 
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Edit source segments 
Previously, the only content you could edit in Studio was content in target translations. You can now 
also make small changes to content in source segments. For example, you might want to correct a 
spelling mistake in a source segment. To edit a source segment, right-click on the segment and select 
Edit Source (or press Alt+F2). Source editing is only supported for the following file types:  doc, 
.docx, .ppt and .pptx. 

Source editing is disabled for: 

 Documents containing tracked changes in the source. 

 Projects that originated from an enterprise system package (for instance, WorldServer, TMS 
and TeamWorks). 

 Locked segments. 

 Packages originating from earlier versions of Studio (Studio 2011 SP1 and Studio 2009 SP3). 

Source editing also has the following restrictions: 

 You cannot enable source editing when you open a project package that has it disabled.  

 If source editing is disabled for the project, then it is disabled for all translatable files in the 
project. 

2.4 Support for document review outside of Studio 

External review 
For reviewers who do not have Studio installed, you can now export the SDL XLIFF file to a bilingual 
docx format which can be opened in Microsoft Word. The reviewed document can then be imported 
back into Studio and the SDL XLIFF updated with tracked changes, reviewed statuses and 
comments. 

Regulatory review pack 
If you work in a regulated industry and have purchased a license containing this feature, you can send 
a bundle of documents to an external regulator for review. A bundle is a zipped file that contains a 
specific collection of documents needed by the regulator.  

You can only create bundles from projects that contain at least one .docx file. You cannot create 
bundles from other file types in Studio.  

Note:  You can create bundles for merged files that contain at least one .docx file.  When the merged 
file also contains another file type then the following documents are created in the bundle: 

 One bilingual review document will be generated containing all content from the merged file 
regardless of their file type. 

 The source, target and final documents will only be generated for.docx files within the merged 
file. 
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2.5 Enhanced PerfectMatch features 

Target segment comments in docx files 
Comments in the target segments can now be transferred to new project files when PerfectMatch is 
applied. They are only transferred when the Use the original translation origin and status option is 
selected.  

For example, if you are applying PerfectMatch in the Middle of a Project scenario where translations 
are taken from bilingual files that have not yet been fully translated or reviewed, you would typically 
want the translations to appear with the original origin, confirmation level and target comments. 

Source segment tracked changes 
When you apply PerfectMatch with tracked changes in the source, the following behavior occurs if you 
select the Use the original translation origin and status option: 

 A segment in the project file and corresponding segment in the bilingual reference file will only 
have PerfectMatch applied if they have identical tracked changes in the source.  

 No PerfectMatch will occur if one of the segments has tracked changes in the source and the 
other one does not.   

When you apply PerfectMatch with tracked changes in the source, the following behavior occurs if you 
select the Apply PerfectMatch and lock option: 

 If a segment in the new project file contains tracked changes in the source, then content from 
the bilingual reference file is not extracted.  

 In a bilingual reference file, source tracked changes are treated as if they were accepted so 
that you can get maximum leverage.   

2.6 New functionality available from Studio to work with SDL 
Studio GroupShare 

 Publishing a project to GroupShare can now be performed during project creation in the New 
Project wizard.    

 If you delete a project from Project Server, you can now republish that project.  

 If you are using SDL authentication, you can now change your GroupShare password from 
the Studio client. By design, you cannot change your password if you are using Windows 
authentication or if you are logged in as one of the built-in GroupShare users (System 
Administrator, MultiTerm Super or MultiTerm Guest). 
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2.7 Support for the new SDL TMS 2011 SP3 release 
Packages created in SDL TMS (Translation Management System) 2011 SP3 containing SDL XLIFF 
files can be opened in Studio. Previously packages from TMS only contained the legacy ITD bilingual 
file format that had to be converted to a Studio bilingual SDL XLIFF format when it was imported into 
Studio. Now packages created in TMS 2011 SP3 can contain SDL XLIFF files as well as the legacy 
ITD format. This is due to the new Studio filters (Adobe InDesign IDML and Adobe InDesign ICML) 
that have been incorporated into TMS.   

2.8 Usability enhancements 

Project activation 
 Double-clicking on a project in the Projects view now takes you directly to the Files view 

where you can view the files within that project. The Open command has also been changed 
to match this functionality. 

 A new Set as Active Project command has been added to the context menu in the Projects 
view. This command makes the project the active project but it remains in the Projects view.  

 The Reactivate Project command has been changed to Revert Project to In Progress. This 
change was made so it would not be confused with the Set as Active Project command. 

File handling 
When you close the last open file in the Editor, it automatically switches to the Files view so you can 
easily open the next file for translation or review. 

History Saved for Display Filters 
Studio now remembers your previous display filter searches in the Editor so you do not have to retype 
them each time. These searches are performed from the Display Filter toolbar. A history of the last 
20 search criteria is retained. This might be useful if you are using a complicated regular expression 
to filter the text. 

To use a previous search string, start typing in the Containing box on the Display Filter toolbar and 
any matching searches are displayed below for selection.  

Center active row in the Editor 
To make viewing of segments that you want to translate or review easier, a new option has been 
added that allows you to center the active row in the Editor. When this option is selected and a row is 
activated, the row is automatically placed in the center of the Editor. 

You can turn on this feature in the Options dialog box (Tools menu) under Editor.  
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Replace function now supports using regular expressions 
You can now use regular expressions to do substitutions when replacing text in the Editor using the 
Find and Replace feature. The regular expression is used to generate the text that will replace the 
matched text in the Find criteria.  

For example, you could use this feature to change the order of words in a sentence across all 
occurrences of that sentence.  

Find Criteria 

Use this regular expression in the Find box: 

 field '(\w+)’ 

It finds matching sentences in the document where XYZ represents the field name: 

 “The field 'XYZ' is displayed." 

For example, it might find the following sentences:  

 “The field Address is displayed.” 

 “The field Name is displayed.”   

 “The field Email is displayed.” 

Replace Criteria 

Use this regular expression in the Replace box: 

 ‘$1’ field  

It changes the sentence order of the matched sentences to the following where XYZ 
represents the field name: 

 "The 'XYZ' field is displayed."   

For example, this changes the order of the matched sentences to the following: 

 “The Address field is displayed.” 

 “The Name field is displayed.”   

 “The Email field is displayed.” 

 

For more information on how to use substitution regular expressions, see for example 
http://msdn.microsoft.com/en-us/library/ewy2t5e0.aspx. 

2.9 Enhanced SDL WorldServer integration 

Package opening time 
The time it takes to open a WorldServer package in Studio has been significantly reduced so you can 
start work on the translation of WorldServer files in Studio quicker than you could before.   
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Merge files when you open a WorldServer package 
When you open a WorldServer project package in Studio that contains any files processed by a 
legacy filter in WorldServer, you are asked whether you want to view these files as one merged SDL 
XLIFF file in Studio. This mimics the behavior that WorldServer users may be familiar with from the 
legacy WorldServer Desktop Workbench tool. When you create the return package to send the 
completed work back to WorldServer, the merged SDL XLIFF file is converted back to the format and 
merged state that was contained in the original project package.  

If a WorldServer package also contains SDL XLIFF files, those files are not merged together and are 
imported into Studio as individual files.  

2.10 Additional pseudo-translation dictionary support 
Pseudo-translation is a procedure which simulates how a translated document will look after 
translation and how much extra DTP or other work will be required before actual translation is done. 
This can help in the planning of the project to set appropriate estimates and expectations. SDL Trados 
Studio now supports running the Pseudo-translation batch task in these additional languages: 

 Russian 

 Ukrainian 

 Japanese 

 Korean 

 Thai 

For a list of fully supported dictionaries, see the SDL Trados Studio Help. 

2.11 Configurable options for AutoSuggest results 

Turn off case sensitivity in your AutoSuggest results 
You can turn off case sensitivity for your AutoSuggest results in the Options dialog box under 
AutoSuggest. This improves your chances of getting results and also allows you to select a word to 
use in the case you want to use.  

With case sensitivity on: 

Type Results 

Foto… Fotodrucker 

foto… No results are displayed 

With case sensitivity off: 

Type Results 

Foto… Fotodrucker 

foto… fotodrucker 
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Sorting AutoSuggest results 
You can sort AutoSuggest results to prioritize certain suggestions over others or to make them easier 
to scan if you have a long list of suggestions. You can change these settings in the Options dialog 
box under AutoSuggest. 

 Sort the list by one of the following within each AutoSuggest provider's list of suggestions:  

o Longest words 

o Shortest words  

o Alphabetically 

 Give priority to certain suggestions based on provider (Termbases, AutoSuggest dictionaries 
and AutoText). 

2.12 Project TM creation 
You can create file-based or server-based project translation memories. The type of TM created is 
now automatically determined based on the type of main translation memory that you have added to 
your project. A server-based project TM is created when you use a server-based TM in your project 
and a file-based project TM is created when you use a file-based TM in your project. If needed, you 
can change this in the Project Translation Memory settings when you run the batch task to create a 
project TM. 

2.13 Enhanced auto-propagation review features 
You can now use Auto-propagation when reviewing documents as well as when translating 
documents. Auto-propagation in review takes place when you approve (confirm) or reject a 
translation. Depending on your settings, the auto-propagated segments are then automatically 
approved or rejected, or have tracked changes applied to them with the new auto-propagated text. 

2.14 Report cross-file repetitions 
Cross-file repetitions are now counted as a separate item in the Analysis report. This counts segments 
that are duplicates of segments in a different file being analyzed in the same task. 

The number of repetitions (identical segments that occur more than once) in each file is counted by 
default in a separate repetitions count. 

2.15 Customize existing bidirectional QuickInsert markers   
For bidirectional languages, such as Arabic and Hebrew, you can customize the existing markers in 
Studio by: 

 Adding the markers to the QuickInsert Toolbar.  

 Changing the keyboard shortcuts assigned to the markers.  See Keyboard Shortcuts for 
Inserting Bidirectional Language QuickInsert Markers for a list of markers and their keyboard 
shortcuts. 

For example, the following bidirectional markers can be customized:  Right to Left Mark (RLM) and 
Left to Right Mark (LRM).  
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2.16 Keyboard shortcut support 

2.16.1 Keyboard shortcuts for navigating windows and views 
New keyboard shortcuts have been created for some of the actions you perform with different 
windows in a view. You can also customize what shortcut keys to use for these actions in the Options 
dialog box.  

Ctrl+Tab or 
Ctrl+Shift+Tab 

Switch between different windows within a view. 

2.16.2 Concordance Search window 
F6 Switch between the source and target segments in the Concordance Search 

window.  

Ctrl+Alt+F3 Insert text from the Concordance Search window into your target segment. 

2.16.3 Keyboard shortcuts for inserting bidirectional language 
QuickInsert markers 

For bidirectional languages, such as Arabic and Hebrew, you can now use keyboard shortcuts to 
insert the bidirectional QuickInsert markers. You can create new keyboard shortcuts for some of the 
markers or customize the existing keyboard shortcuts in the Options dialog box under Keyboard 
Shortcuts. 

Ctrl+Alt+Shift+R RLM – Right to Left Mark 

Ctrl+Alt+Shift+L LRM – Left to Right Mark 

Create Customized 
Keyboard Shortcuts 

LRE – Start Left to Right Embedding 

RLE – Start Right to Left Embedding 

RLO – Start Right to Left Override 

LRO – Start Left to Right Override 

PDF – Pop Directional Formatting 

2.16.4 Keyboard shortcuts for working with MultiTerm termbases 
The following MultiTerm actions now have keyboard shortcuts in the Editor. You can customize these 
in Options dialog box under Keyboard Shortcuts. 

Ctrl+F2 Add New Term 

Ctrl+F12 Save Term 

Note:  When working in the Termbase Viewer window, you can also still use 
the legacy MultiTerm keyboard shortcut:  F12 

Ctrl+F10 Cancel Term Editing 

Note:  When working in the Termbase Viewer window, you can also still use 
the legacy MultiTerm keyboard shortcut:  Shift+Escape 
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F2 Edit the Entry 

Note:  This legacy MultiTerm keyboard shortcut (F2) can only be used when 
working in the Termbase Viewer window.  

2.17 Enhanced support for file types  

Adobe file types 
 Studio now supports Adobe CS6 (InCopy and InDesign). 

 Studio now supports FrameMaker 11 MIF files. 

Microsoft file types 
 There is improved support for bidirectional languages in Microsoft Word 2007-2010 

documents (.docx). 

 You can now specify translation rules for text embedded in Excel files and so process any text 
into tags. This extends to Excel files the functionality that already exists for XML and Java 
resource files. 

 You can now specify how to handle tracked changes for Microsoft Word 2007-2010 
documents (.docx). 

XML file types 
 For XML verification, Studio now uses locally stored copies of some schemas and DTDs. 

Using these local copies appreciably speeds up verification. 

 Studio now supports DITA 1.2. 
 
Note: If you are upgrading from Studio SP1 to Studio SP2, DITA 1.2 does not immediately 
appear in the list of supported file types although it is installed. To add DITA 1.2 to the list of 
supported file types, do the following: 

1.  Click Tools > Options  

2. In the left pane of the Options window, click File Types. 

3. Click the link in the right pane labeled: Additional installed File Types exist and 
select DITA 1.2. 

 Studio provides improved performance for SDL XLIFF files. Studio achieves this by loading 
SDL XLIFF files more efficiently than previously. 
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3 Installation 
Note:  If you install SDL Trados Studio 2011 SP2 and also have SDL MultiTerm 2011 installed, you 
must upgrade MultiTerm to the 2011 SP2 version to be able to use both applications in tandem.  

3.1 Prerequisites 
Hardware: 
 

 SDL Trados Studio 2011 SP2 requires a PC with a 1 gigahertz (GHz) or faster 32-bit (x86) or 
64-bit (x64) processor and 1 GB RAM (32-bit) or 2 GB RAM (64-bit). 

 It needs a mouse or similar pointing device. 

 Display settings should be at least 1024 by 768 pixels, and 256 colors. 
 
 2 GB of available disk space is required to run SDL Trados Studio.  
 
 The SDL Trados Studio installer requires 1.2 GB of disk space (1.7 GB if your PC runs 

Windows 7 or higher). 
 
For optimum performance we recommend the following: 
 
 Recent Pentium or compatible processor (using recent dual core or multi core technology) 

with 2 GB RAM or more. 
 

Platforms: 
 

 SDL Trados Studio 2011 SP2 runs on the latest service-packed versions of Windows XP, 
Windows Vista and Windows 7. Windows 2003 Server and Windows 2008 Server are also 
supported to facilitate scenarios, for example where Citrix or terminal services are used. 
 

 Earlier operating systems such as Windows 2000, Windows NT, Windows 98, Windows XP 
pre-SP3 and Windows 2003 pre-SP2 are not supported. 
 

 We recommend that users sharing packages always work with the same operating system as 
the number of supported languages can vary depending on the operating system that you are 
using. 
 

Software: 
 SDL Trados Studio 2011 SP2 fully supports all Microsoft Office 2000-2003 and 2007-2010 file 

formats. An installation of Microsoft Office 2007 or 2010 is required if you want to use the 
preview features in SDL Trados Studio. Microsoft Word is required for MS Word spell-
checking.  
 

 Microsoft Word 2003 is the minimum requirement for processing RTF-based and PDF files. If 
you are using the real-time preview feature, we recommend that you use Microsoft 2007 or 
2010 as certain issues may occur if you are using Word 2003. Potential workarounds are 
described in the knowledge base at http://kb.sdl.com. 
 

 Microsoft Excel 2000 – 2003 can be used but Studio will use a file filter to convert to Excel 
2007 and back again. For this to work correctly, install the Microsoft 2007 compatibility pack 
from http://www.microsoft.com/downloads. 
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Browsers: 
 Microsoft Internet Explorer 6 is the minimum requirement for SDL Trados Studio. You need 

this for displaying the online help. 
 
 If you access the help directly in a browser instead of clicking the Help button inside the 

Studio application, you can also use Mozilla Firefox 2 or higher. 
 
For more information on the prerequisites for installing SDL Trados Studio 2011 SP2, see the SDL 
Trados Studio 2011 SP2 Installation Guide.  

3.2 Install and upgrade process 
Whilst installing SDL Trados Studio, ensure that: 

 You have administrator rights. 

 No other software is running. 

A full list of the software, including third party software, installed with this application is listed in the 
SDL Trados Studio 2011 SP2 Installation Guide. 

The SDL Trados Studio installer and guide can be downloaded from your SDL My Account: 
https://oos.sdl.com/asp/products/ssl/account/ 

Follow the instructions for installation in the SDL Trados Studio 2011 SP2 Installation Guide: 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Guides/StudioClient_Installation_en.p
df 

SDL Passolo Essential 2011 SP6 is also included in this installation. 

SDL Trados Studio 2009 installation:  

SDL Trados Studio 2011 SP2 installer replaces your installation of SDL Trados Studio 2009.  

If you plan to install and use SDL Trados Studio 2009 and 2011 SP2 side-by-side, you should install 
SDL Trados Studio 2009 first. 

See http://kb.sdl.com/ for the latest information on installation issues and their resolutions. 

3.3 Compatibility 
SDL software  

SDL Trados Studio 2011 SP2, 2011 SP1 and 2011 have the same project and package format. SDL 
Trados Studio 2011 SP2 can run alongside SDL Trados Studio 2009. 2009 projects are automatically 
converted to 2011 SP2 when you open them for the first time in Studio 2011 SP2.  

You can send translation packages back and forth between 2009 SP3 and 2011 SP2.  To create 
packages in 2011 SP2 that you can open in 2009 SP3, select Project > Create Studio 2009 Project 
Package.  

Note: Before creating 2009 packages, you should ensure that your SDL XLIFF file type settings 
embed the source files so that file types not supported in 2009 can still be edited. To do this, set the 
Embedding to 100 MB under the File Types > SDL XLIFF > General settings. We recommend 
changing this setting in the project template (or default template via Tools > Options) prior to creating 
the project. 
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If you are creating or working on Studio 2009 packages that include INX, Java properties, PDF or 
OpenOffice files in Studio 2011 SP2 or upgrading them to 2011 SP2, you can work on these and 
return them. However, you cannot save as target or preview such files as Studio 2011 SP2 uses later 
versions of these file types that are not backward compatible for previewing or saving as target. We 
recommend that you keep both Studio 2009 and Studio 2011 SP2 side-by-side so that you can flexibly 
plug into the different supply chains as required and that you finish ongoing projects in the version in 
which they were created. This means it is better to finish running projects in Studio 2009 before 
switching to Studio 2011 SP2. 

SDL Trados Studio 2011 SP2 can also be installed alongside SDL Trados 2007. SDL Trados Studio 
2011 SP2 also contains its own version of the SDL Trados 2007 infrastructure so all use cases that 
require Trados 2007 will still work even if it is not installed. The following are supported: 

 WinAlign and S-Tagger 

 ITD 

 TTX 

 Upgrading TMW 

 Upgrading MDB 

For extensive information on backward compatibility and upgrading TMs, refer to the online help and 
the SDL Trados Studio 2011 SP2 Migration Guide, which is included in the Start program menu for 
SDL Trados Studio 2011 SP2. 

SDL server software  

SDL Trados Studio 2011 SP2 is compatible with: 

 SDL Studio GroupShare (TM Server 2011, MultiTerm Server 2011, Project Server 2011) 

 SDL MultiTerm 2009 Server SP3 and SDL TM Server 2009 SP3  

SDL client software 

Both SDL MultiTerm 2009 and 2011 SP2 can be used on the same computer as SDL Trados Studio 
2011 SP2.  

Note:  If you install SDL Trados Studio 2011 SP2 and also have SDL MultiTerm 2011 installed, you 
must upgrade MultiTerm to the 2011 SP2 version to be able to use both applications in tandem.  

SDL enterprise software 

SDL Trados Studio 2011 SP2 is compatible with SDL TMS 2007 - 2011, SDL TeamWorks 2007 - 2011 
and SDL WorldServer 2010 - 2011. 

Non-SDL software  

Adobe FrameMaker 8.0 MIF files translated into Japanese may not display correctly in Adobe 
FrameMaker 8.0. For example, some Japanese characters appear to drop out of the translated file. 
This issue may also occur in non-Japanese FrameMaker 8.0 MIF files with certain extended 
characters, such as the arrow-up or arrow-down characters or smart quotes. This behavior is caused 
by a bug in Adobe FrameMaker version 8.0 that means that such files are not correctly parsed by the 
FrameMaker application. The translated characters are all intact if you look at the MIF content in a 
text editor. However, FrameMaker is unable to display and use the file correctly. Adobe has corrected 
this issue with Adobe FrameMaker 9.0 so SDL recommends that you upgrade to this version. 
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3.4 Supported releases 
On the release of SDL Trados Studio 2011 SP2, we will continue to support SDL Trados Studio 2009. 
As an exception to SDL policy, we also confirm continued support for the SDL Trados 2007 product 
suite, which we consider as mature (and not yet retired) products. Mature releases are still supported. 
Hotfixes to all three generations are released as and when required and service packs are released at 
the discretion of SDL.  

With the next major release of SDL Trados Studio, we will consider moving SDL Trados 2007 to a 
retired state. Retired means that this release only qualifies for limited technical assistance subject to 
the availability of trained personnel and resources. No further service packs or hotfixes will be issued. 

 

With this release, we also announce limited support (no new feature development) for the following 
filters (this will be reassessed in the next major release of SDL Trados Studio and a potential 
alternative will be offered at that time): 

‐ Word binary *.doc 

‐ PowerPoint *.ppt 

3.5 Localization 
The user interface for SDL Trados Studio 2011 SP2 is localized into the following languages:  

 German 

 French 

 Spanish 

 Japanese 

 Simplified Chinese  

The online help for SDL Trados Studio 2011 SP2 is localized into: 

 German 

 French 

 Japanese 

 Simplified Chinese  

The Quick Start Guides for SDL Trados Studio 2011 are localized into: 

 German 

 French 

 Japanese 

 Simplified Chinese  
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4 Resolved Issues 
SDL Trados Studio 2011 SP2 contains all previous cumulative updates for SDL Trados Studio 2011 
and 2011 SP1 as described in KB article 4077. These as well as other key fixes and enhancements 
are listed below. 

Description 

You can now import content from an SDLXLIFF file into a TM even when the language variant 
differs from the TM language variant. For example, if you are importing into an English (United 
Kingdom) / German (Germany) TM, you can import English (United States) / German (Germany) 
translation units. 

When you try to edit a TM in Studio in the Translation Memories view and it has been deleted 
or moved from the file structure on your computer, a message is displayed indicating that the file 
is no longer in that location.  

A 'missing tag' penalty is now applied to segments that are auto-propagated and have tags 
missing from the target segment.  

You can now send packages by email from Studio if you have Microsoft Office 2007 installed. 
Both Microsoft Outlook 2007 and Microsoft Outlook 2010 are supported. 

When you are translating with more than one termbase in the Editor, you can now choose to 
disable one or more termbases.  

You can now split segments even within a tag pair as you could do in SP1. This allows you to 
work better with heavily formatted documents that you are asked to translate.  

Auto-localization of numbers now works even when you have the following Measurements 
option selected: 

Use the same spacing between the number and the unit that is used in the translation 
memory target segment.  

File types: 

‐ Studio now provides enhanced stability and robustness in the file type handling for 
Microsoft Office files (PowerPoint, Excel, Word) and Adobe (inx, .idml, .icml, .inx) files. 

TeamWorks packages that contain guidelines now appear in Studio as reference files. You can 
access these files from the Files view in a Guidelines folder under the source language. 

When working with a file that has a high quantity of segments and large termbases, out of 
memory errors are no longer displayed.  

Licensing 

‐ Studio now supports time-limited network licenses. 

‐ Studio also now supports trial network licenses in Windows Server and Citrix/Terminal 
Services. 

‐ Studio client no longer takes up multiple seats when connecting to the Licensing Server 
Toolkit (Version 1.2). 

Note:  For the most up-to-date information about licensing and Studio, refer to the SDL 
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Knowledge Base.  

Comments 

‐ The Comments window in the Editor now displays the number of comments in the tab 
title.  

‐ Delete all target comments in the Active document now only deletes those 
comments in the currently active document instead of all comments in open documents.  

Spell Checker 

‐ Comments in the middle of a word no longer cause spell checking errors. 

‐ You can now use the Microsoft Word spell checker for Welsh on Windows 7 when it is 
set to Welsh with the Welsh language pack. 

Splitting confirmed segments in the editor no longer produces negative word counts on the 
status bar in the Editor. 

It is now possible to set Indexes if all languages are not present in your Default Termbase. For 
example, if you create a multilingual project (EN-FR and EN-DE) and then you add two 
termbases (one for EN-FR and one for EN-DE).   You can now specify the indexes for the 
languages that do not exist in the default termbase. 

Google Translate is now supported in any position in the translation provider list. You can now 
work with QuickPlace and view TM differences even when Google Translate is last on the 
translation provider list.  
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5 Known Issues 
For the latest information on known issues, view the release notes attached to this KB article SDL 
Trados Studio 2011 SP2 Release Notes (4374) on the knowledge base at http://kb.sdl.com.   

Description 

When you add custom columns to any of the views by right-clicking and selecting 
the Customize command from the shortcut menu, these columns may get added to 
the right rather than the left-hand side of the Gantt chart. If this happens, you can 
drag the columns over to the left. 

For optimum alignment exports using SDL Trados WinAlign into translation 
memories for some of the more recently supported languages such as Hindi, SDL 
recommends using the TMX 1.4 feature rather than TXT-based exports. SDL also 
recommends using Arial Unicode MS as a font for the new languages and switching 
to user-defined segment formatting in the event of text display issues in WinAlign. 
For other languages, SDL recommends the TXT-based export from WinAlign. 

If you attempt to run the Freelance or Starter version of Studio on a domain-based 
network, a message appears stating that it is not possible to run the Freelance or 
Starter version on such a network. This is by design and does not occur on 
workgroup-based networks or stand-alone computers. 

When using file-based termbases in Studio 2011 SP2: We advise you not to use 
termbases on a network drive as MultiTerm needs to write various files alongside 
the termbase. Retry by copying the termbase locally. 
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Planned Support  

5.1 Contacting technical support 
For information on how to get technical support: 

Article: http://tinyurl.com/SDLProductsSupport 

http://www.sdl.com/en/language-technology/support/. 

5.2 Enhancement requests 
To suggest or discuss SDL Trados Studio 2011 SP2 enhancements, visit http://ideas.sdl.com/. 

This community forum is designed to foster an environment of collaboration where customers can 
interact with SDL and other users. 

5.3 Further information 

SDL Trados Studio Help 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/SDL_Trados_Studio_Help.htm 

You can find the following information in the online help: 

 Online Help Topics:  This includes information about how to use Studio, Studio licensing and 
how to use Studio in a GroupShare environment.  

 Videos  

 Quick Start Guides  

 Migration Guide 

 Installation Guide 

SDL Studio GroupShare Help  

http://producthelp.sdl.com/SDL studio groupshare/en/index.htm 

You can find the following information in the online help: 

 Online Help Topics:  This includes information about how to use the web interface for SDL 
Studio GroupShare and trouble-shooting topics. 

 Videos 

 Installation Guide 

SDL Licensing Server Toolkit Guide 

This guide can be downloaded with the SDL Licensing Server Toolkit Installer from your SDL My 
Account: https://oos.sdl.com/asp/products/ssl/account/ 

The guide is for license administrators who need to set up network licensing. 

 

 


